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1 WSTĘP
Niniejsza instrukcja jest skonstruowana zgodnie z zasadniczą kolejnością wykonywania operacji (rozdziały 
2 - 6) przy realizacji pracy zaliczeniowej w programie Apple Final Cut Pro X. FCPX jest profesjonalną 
aplikacją służącą do montażu nieliniowego materiałów audiowizualnych (podobnie jak Adobe Premiere Pro, 
od którego produkt Apple się historycznie wywodzi). Omawiana wersja programu różni się odejściem od 
interfejsu użytkownika podobnego do rozwiązań klasycznych znanych z Final Cut Pro i Final Cut Express 
(jak w produktach Avida czy Adobe). Nawiązuje zaś do rozwiązań wypracowanych przez inżynierów Apple 
w ostatnich wersjach programu iMovie. Zmieniona została też w pewnym stopniu filozofia obsługi (wprowa-
dzenie obiektów Storyline) oraz zakres możliwości dawanych przez standardowe filtry i efekty (tytułówka 3d, 
animowane maski wektorowe,…) oraz obsługę rozmiarówek z grupy 4k i 5k.
Opis dotyczy standardowego układu okien i palet przy pracy w trybie klasycznym (nie pełnoekranowym) 
z wykorzystaniem jednego monitora. Jeżeli wygląd obszaru roboczego na Twoim stanowisku znacznie 
odbiega od opisywanego – zapewne został on przekonfigurowany przez poprzedniego użytkownika. 
W celu przywrócenia domyślnej konfiguracji należy skorzystać w menu Window z polecenia: Workspaces 
-> Default.

1.1 OBSZAR ROBOCZY
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2 POCZĄTEK PRACY Z PROGRAMEM
Rozpoczynając pracę na zajęciach z Obróbki Plików Filmowych, przede wszystkim warto trzymać się 
jednego stanowiska roboczego (są one opisane numerami z przodu na białych prostokątach). Na wybra-
nym stanowisku najlepiej założyć w teczce dokumentów imienny folder. Zaś w owym folderze przechowy-
wać wszystkie swoje pliki. Jak i co pewien czas dokonywać kompletnego jego bakapu (najlepiej poprzez 
utworzenie z niego archiwa w postaci pliku ZIP, który można zapisać na innym prywatnym, niezależnym 
nośniku).

2.1 PRZYGOTOWANIE ŚRODOWISKA PRACY
Zaczynając pracę z FinalCutProX po pierwszym 
uruchomieniu programu (gdyby poprzedni użytkow-
nik zbytnio zindywidualizował organizację ekranu 
zawsze możesz użyć polecenia Window -> Work-
spaces -> Default) wypada pozamykać nieużywane 
(cudze) biblioteki po kolei wskazując je kursorem 
poleceniem File -> Close Library “nazwa_biblioteki”, 
do momentu gdy nie będzie dostępna żadna.
Warto też sprawdzić nastawy programu poleceniem 
Final Cut Pro -> Preferences i je miejscami skorygo-
wać. 
W zakładce General sposób wyświetlania czasu 
(Time Display) należy przestawić na HH:MM:SS:FF. 
Będzie on opisywany w postaci licznika godzin:mi-
nut:sekund:klatek. Ponieważ będziemy pracować 
głównie w PAL SD/HD (wykorzystując podstawę czasową 25 fps jeśli to tylko możliwe progresywnie, a nie 
z przeplotem) oznacza to, że w każdej sekundzie pierwsza jej klatka ma numer 0 a ostatnia 25.
W zakładce Editing można między innymi regulować czas trwania zaimportowanych materiałów nierucho-
mych (Still images) jak i domyślną długość przejść między ujęciami (Transition).
W zakładce Playback można określić tło ekranu (Player Background). Szczególnie przydatna jest tam 
nastawa Checkerboard symulującą przezroczystość 
w analogiczny sposób jak np. w Adobe Photosho-
pie. Warto z niej korzystać gdy w FCPX przygotowu-
je się materiały do umieszczenia w innych projek-
tach o strukturze warstwowej. 
W zakładce Import należy wybrać sposób obsługi 
danych zorientowany na kopiowanie materiałów 
do biblioteki (Files: Copy to library storage location). 
Gdy chcemy podnieść komfort pracy (lub korzysta-
my ze słabego stanowiska komputerowego) często 
warto w opcji Transcoding zaznaczyć Create 
optimized media - program będzie generował w tle 
łatwiejsze do obsługi (acz mniej złożone pod 
względem mechanizmu kompresji czyli większe 
pliki). Ich przeliczenie wymaga czasu. Proces ich 
przygotowania widoczny jest w oknie Background Tasks (jeżeli nie wiesz gdzie znaleźć dane okno, lub czy 
jest widoczne, skorzystaj z menu Window).W zakładce Destination możemy wskazać jaki opcje wyjścia są 
dostępne w Share. Z punktu potrzeb na zajęciach Obróbki Plików Filmowych, potrzeba jedynie Master File 
(default), gdyż zrealizowane projekty, ze znacznikami rozdziałów będą wykorzystywane w niezależnej 
aplikacji do masteringu płyt Video-DVD.

2.2 ORGANIZACJA SYSTEMU PRZECHOWYWANIA DANYCH
Utwórz własną bibliotekę w swoim imiennie podpisanym folderze poleceniem 
File -> New -> Library. Jak widać w nowo powstałej bibliotece mamy od razu 
do dyspozycji mechanizm automatycznego segregowania typów mediów 
(Smart Collections) jak pierwsze wydarzenie (opisane datą utworzenia). W nim 
będą przechowywane projekty (czyli kompozycje montażowe - przyszłe filmy) 
jak i ich potencjalne składowe (grafiki, zdjęcia, materiały fimowe i audio).
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3 IMPORTOWANIE MATERIAŁÓW
W Program FCPX dostępne są pewne podstawowe możliwości kreowania bez wykorzystania materiałów 
zewnętrznych filmu. Można wykorzystać gotowe statyczne i animowane tła, generatory napisów czy zbiór 
dźwięków. Jednakże podstawową metodą pracy jest w programie montażowym jest wykorzystanie pobiera-
nych z zewnątrz elementów w postaci materiałów audiowizualnych czy nieruchomych obrazów i tworzenie 
z nich docelowego dzieła.

3.1 PLIKI WIDEO
Najbardziej podstawowym typem materiału są (udźwiękowione lub nie) 
filmy. Mogą być one dostępne w postaci plików dostępnych na nośniku 
pamięci (dysku komputera czy kamery, karcie pamięci itd.). Dostęp do nich 
jest analogiczny do dostępu do innych plików. Trochę bardziej złożone jest 
korzystanie z nośników taśmowych z wykorzystaniem magnetowidu lub 
bezpośrednie pobieranie obrazu z kamery (może być ona zewnętrzna lub 
zintegrowana z komputerem). W celu rozpoczęcia proces importu wybiera-
my polecenie File -> Import -> Media. Wywołane zostanie okno Media 
Import, w którym po lewej stronie możemy wybrać źródło. 

3.1.1 KAMERA/MAGNETOWID
W wypadku urządzeń w standardzie DV (czy konsumenckim miniDV) 
wykorzystujących standard FireWire / IE1394 zalecane jest wcześniejsze 
uruchomienie w/w urządzenia niż aplikacji. W wypadku korzystania ze 
źródeł konwertujących sygnał z analogowego na 
cyfrowy, najbezpieczniej jest uprzednio podłączyć 
wyłączone urządzenia. Następnie je uruchomić od 
źródła sygnału (kamera, magnetowid, tuner) 
poprzez układ pośredniczący (konwerter), a na 
końcu aplikację. W wypadku urządzeń cyfrowych 
zazwyczaj jest możliwość sterowania nimi (przyci-
ski na dole okna podglądu obrazu: odtwarzanie, 
przewijanie itd.). Podobnie jest z urządzeniami 
analogowymi sterowanymi interfejsem LANC. 
W przeciwnym razie musimy sterować całym 
procesem ręcznie (wykazując się nie rzadko 
zręcznością i szybkością). Do sterowania pobiera-
niem materiału służą przyciski Import i Stop Import 
w prawej dolnej części okna Media Import. Po 
zaimportowaniu potrzebnych treści należy 
zamknąć okno (czerwony przycisk w jego lewym 
górnym narożniku).
Najlepiej materiały wideo importować z zapasem 
(kilku czy kilkunastu dodatkowych sekund na 
początku i końcu każdego ujęcia). Jeżeli sami 
jesteśmy operatorem – pomyślmy o adekwatnym 
przygotowaniu ujęć już na planie zdjęciowym.

3.1.2 KODEKI WIDEO
W wypadku przynoszenia na zajęcia uprzednio przygotowanych materiałów wideo warto zadbać by przy-
niesione zostały w postaci akceptowalnej dla Final 
Cut Pro X. Najważniejszy jest kodek, a nie kontener 
multimedialny. To czy plik ma rozszerzenie np. 
.MOV czy .AVI nie wskazuje jednoznacznie na to 
czy będzie odpowiedni. Najprościej możemy 
sprawdzić to w domu korzystając z darmowej 
aplikacji Apple QuickTime Player (dostępna dla 
systemów Windows i Mac OsX). Jeżeli posiadamy 
ją w podstawowej wersji (bez doinstalowanych 
dodatkowych kodeków) to jeżeli przewidziane do 
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montażu pliki uruchamiają się na niej poprawnie - mamy 95% szans, że w pracowni będzie analogicznie. 
Jeżeli natomiast pliki nie działają, warto przekonwertować je (programami darmowymi, jak np: Avidemux, 
czy komercyjnymi jak np: Adobe Media Encoder) do właściwej postaci. W wypadku materiałów w jakości 
SD najodpowiedniejszym będzie kodek DV (raczej bez znaczenia, czy zapisany w kodeku multimedialnym 
.MOV, .AVI czy .DV). Materiały HD lepiej przenosić używając H.264 do obrazu i AAC lub MP3 do audio. Ten 
typ kodeka można regulować. Najistotniejsza jest przepustowość. Jeżeli będzie ustawiona poniżej 2-3 
Mbps, nie należy oczekiwać zbyt dobrej jakości obrazu. Audio warto by miało próbkowanie nie gorsze niż 
44.100 kHz i przepustowość minimum 160 kbps. Taki plik można przenieść w kontenerze np: .MP4, .MOV, 
.AVI. Pamiętaj, że na stanowiskach w pracowni jest zainstalowany Adobe Media Encoder z pakietu CS6.

3.1.3 IMPORT PLIKÓW Z NOŚNIKÓW NIETAŚMO-
WYCH 
Po wybraniu polecenia File -> Import -> Media 
ukaże się okno Media Import w którym (przegląda-
jąc nośniki pamięci) możemy skazać plik (lub ich 
grupę) przeznaczony do umieszczenia w naszym 
projekcie. Już na etapie wskazywania plików 
możesz je obejrzeć / odsłuchać. Nie wymagana 
jest do tego zewnętrzna przeglądarka.

3.2 PLIKI AUDIO
Analogicznie postępując można umieścić w bibliotece projektu pliki audio. Są one zazwyczaj na tyle małe, 
że można bez problemu (efektywność pracy) korzystać z postaci nisko skompresowanej lub bez kompresji. 
Warto by miały one próbkowanie nie gorsze niż 44.100 kHz, a w wypadku kodeków kompresujących 
stratnie, przepustowość nie mniejszą niż 160 kbps.

3.2.1 KODEKI AUDIO
Najlepiej jeżeli możesz korzystać z nieskompresowanego materiału dźwiękowego zapisanego w plikach 
.WAV lub .AIF (.AIFF). Najczęściej spotykanym nośnikiem takiej muzyki jest płyta Audio-CD. Możesz pobrać 
z niej utwory korzystając z darmowego programu Apple iTunes (dostępnego na platformy Windows i Mac 
OsX). Innym popularnym, acz gorszym zazwyczaj jakościowo typem pliku jest .MP3.

3.3 ZDJĘCIA I GRAFIKI
Final Cut Pro X może importować pliki zawierające grafikę bitmapową. Najlepiej by była ona w palecie barw 
RGB. Mogą być to pliki z warstwami (tylko format .PSD nagrywany w opcji pełnej kompatybilności; warstwo-
we pliki .TIF są przy imporcie zmieniane na monolityczne) jak i ich pozbawione (.JPEG, .PNG i wiele 
innych). Program rozpoznaje kanał przezroczystości w plikach .PSD i .PNG (w wersji 24 bitowej). Korzysta-
nie z plików .GIF i .PNG (8 bitów) ze względów jakościowych nie jest zalecane. Wektorowe pliki .PDF po 
zaimportowaniu obsługiwane są jak bitmapy. 
Wielostronicowe pliki .PDF przetwarzane są na 
film.

3.3.1 PLIKI WIELOWARSTWOWE
W trakcie pobierania materiałów do projektu. 
Podczas pracy z oknem Media Import gdy zazna-
czymy plik .PSD, który Final Cut Pro X rozpozna 
jako wielowarstwowy – wyświetli w lewym górnym 
narożniku paska symbolizującego podgląd mate-
riału ikonkę o tym informującą. Analogiczna ikona 
będzie widoczna na jego reprezentancie w oknie 
biblioteki.
Aby móc edytować jego zawartość należy w oknie 
biblioteki kliknąć na ów klip prawym klawiszem 
myszy i wybrać z menu kontekstowego polecenie 
Open Clip. Otworzy się on wtedy w oknie osi 
czasu (Time Line). Możemy już wtedy dowolnie 
edytoć (w zakresie możliwości programu) wszyst-
kie (oprócz najniższej) z tworzących je warstw. 



SKRÓCONA INSTRUKCJA DO PROGRAMU FINAL CUT PRO X - Jakub Balicki - IIS - PŁ - 2017 strona 5

Aby również ta ostatnia była w pełni dostępna, należy kliknąć na niej prawym klawiszem myszy i wybrać 
z menu kontekstowego polecenie Lift from Storyline.
Import i reedycja wielowarstwowych plików .PSD jest jedną z najprostszych dróg do stworzenia dwuwymia-
rowej animacji, ze zdjęć, typografii czy elementów graficznych.

4 ROZPOCZĘCIE MONTAŻU
Projekt należy stworzyć w docelowych nastawach jakościowych. W tym celu wybieramy z menu File polece-
nie New -> Project.
Określając jakość materiału wybieramy raczej pomiędzy PAL SD 720x576 DV 25i (kadr 4:3) lub dolnym HD: 
720p HD 1280x720 25p 
(kadr 16x9) w obu 
wypadkach z renderin-
giem w Apple ProRes 
422 LT i dźwiękiem 
stereo 48kHz. Nie są to 
nastawy oferujące 
wysoką jakość - lecz 
takie, które umożliwiają 
(znośną) pracę na 
stanowiskach z Intelami 
Core 2 Duo (którymi 
obecnie dysponujemy 
w pracowni).
Projekt może składać się 
z licznych zaimportowa-
nych składowych lub 
i wykorzystywać ich 
kompozycje zwane Compound Clip. Klip taki można stworzyć poprzez kliknięcie prawym klawiszem myszy 
w bibliotece (nie będącym projektem) i wybranie z menu kontekstowego New Compound Clip. Zaletą tych 
obiektów jest przechowywanie wielowarstwowej struktury i możliwość zagnieżdżania jednych w drugich 
oraz projektach. Nie nadają się jednak do końcowego eksportu (pod kątem masteringu Video-DVD). W tym 
celu musimy przewidziane do eksportu obiekty umieścić w projekcie. Stworzyć tam znaczniki rozdziałów 
i dopiero eksportować.

4.2 UMIESZCZANIE SKŁADOWYCH W PROJEKCIE
Najprostszą metodą pracy jest przeciąganie materiałów z biblioteki do okna linii czasu. Po przeciągnięciu 
pierwszego elementu, upadnie on automatycznie na rdzeń struktury filmu zwany Storyline i “przyklei się” 
do jego początku (można zawsze “odkleić” klip poleceniem z menu kontekstowego Lift from Storyline). 
Kolejne składowe (filmy, zdjęcia, grafiki, muzykę, tytułówkę) można narzucać dowolnie. Na lini czasu nie ma 
stałych warstw, jej układ będzie dostosowywał się samoczynnie.
Znacznie lepszą jednak metodą jest wstępne przygotowywanie materiałów przed umieszczeniem na osi 
czasu. Zazwyczaj polega ono na określeniu zakresu czasowego który chcemy wykorzystać 
z zaimportowanego klipu audio lub wideo. W tym celu należy kliknąć wybrany klip w bibliotece (gdy zosta-
nie zaznaczony pojawi 
się wokół niego gruba 
żółta obwiednia).
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Wskazuje ona jednocześnie zakres czasowy przeznaczony do przemieszczenia na Timeline. Można go 
zawężać na dwa sposoby. Chwytając i przeciągając kursorem boki ramki. Lub ustawiając kursor 
w pożądanym miejscu i naciśnięcie klawisza I (jak In) dla początku, lub O (jak Out) dla końca. Zasadniczo 
bywa błędem umieszczanie w Timelinie klipów nieskróconych. Mogą one powodować niepoprawne działa-
nie przejść pomiędzy ujęciami (Transitions). Podczas ograniczania długości klipu – klatka nad którą znajdu-
je się kursor jest wyświetlana zarówno w ikonce materiału jak i na oknie ekranu wideo. Tak przygotowany 
wycinek możemy przeciągnąć kursorem (chwytając za środek selekcji) do Timeline aktywnego projektu lub 
Compound Clipu.
Czasami klip jest dłuższy i składa się nie z jednej “klatki”, a całej ich serii. Wskazuje na to “oddarty” 
w zygzak brzeg materiału. Kolejne oddarte klatki to ciąg dalszy tego pliku (aż odnajdziemy brzeg bez 
“oddarcia”).

5 MODYFIKACJA SKŁADOWYCH FILMU
Po umieszczeniu na Timeline składowych filmu (klipów wideo, audio, zdjęć, grafik itd.) można je oczywiście 
przemieszczać w lewo i prawo (bliżej początku i końca filmu). Zmieniać ich strukturę pionową (korzystając 
z zasad kompozycji warstwowej, gdzie obiekty umieszczone wyżej, zasłaniają te znajdujące się niżej czyli 
“z tyłu”). Modyfikować ich zawartość czasową, długotrwałość, punkty początku jak i końca. Dzielić je na 
fragmenty. przemieszczać, obracać itd. w kadrze. Zmieniać krycie i metody mieszania warstw wizualnych. 
Przetwarzać filtrami, lub spajać złożonymi przejściami. Uzupełniać o tytułówkę.

5.1 NARZĘDZIA
Na pasku rozdzielającym górną i dolną połowę ekranu (w jego standardowym układzie) po lewej stronie 
znajdziemy ikony czterech metod powiązywania lub osadzania klipów na Storyline. Zaś obok (w stronę 
środka ekranu) przełącznik siedmiu narzędzi (dostępnych w rozwijanym menu) służących do:
• Select – zaznaczania obiektów na osi czasu i w oknie ekranu wideo.
• Trim – pozwala na nowo regulować punkty In i Out klipu na Timelinie poprzez ich przeciągnie, albo 
przemieszczanie wnętrza klipu, co powoduje edycję obu zakończeń jednocześnie,
• Position – w obrębie Timeline działa podobnie jak 
Select, ale pozwala przemieszczać obiekty bez 
automatycznego magnetycznego przyciągania do 
zakończeń innych klipów.
• Range selection – pozwala zaznaczyć od modyfi-
kacji (np. fragment krzywej kontrolnej parametru).
• Blade – dzieli klipy w miejscu kliknięcia (z wciśnię-
tym Shiftem tnie wszystkie klipy i tracki w pionie 
w osi kliknięcia).
• Zoom – przybliża i oddala (z wciśniętym klawi-
szem Alt) fragmenty Timeline lub obraz w oknie 
wideo.
• Hand – analogicznie w obu tych oknach pozwala 
na łatwe przesuwanie zawartości.

5.2 SZYBKA EDYCJA
W dolnej lewej połowie okna wideo znajdują się trzy ikony podstawowych grup 
narzędzi do (od lewej): zmian cech geometrycznych, ulepszania obrazu lub 
dźwięku i zarządzania dynamiką i tempem odtwarzania klipu. Aktywując 
pierwsze z nich mamy dostęp do Transform – powoduje ono wyświetlenie na 
ekranie Boudingboxa, przeciągając, obracając lub skalując który mamy wpływ 
na położenie, nachylenie i rozmiar wyświetlanego obrazu. Kolejne – Crop 
pozwala kadrować, obraz lub używać efektów przejść Kena Burnsa (przesunię-
cie z skalowaniem). Ostatnie – Distort, pozwala na czteropunktową deformację 
pseudoperspektywiczną”. Podczas pracy z każdym z nich w prawym górnym 
narożniku okna wideo mamy przycisk Done zatwierdzający dokonane zmiany, 
zaś w lewym przyciski do kontroli klatek kluczowych, lub próbnego podglądu 
uzyskanego efektu.
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Środkowa grupa narzędzi pozwala: automatycznie 
poprawiać kolor (Balance Color), Dopasowywać go 
do innego wskazanego pliku (Match Color…) lub też 
wyświetla stół “mikserski” do koloru (Show Color 
Board) mający trzy zakładki (barwy, nasycenia 
i ekspozycji). Pod linią dzieląca znajdują się analo-
giczne narzędzia do dźwięku. Automat ulepszający 
(Auto Enhance Audio) i polecenie dopasowania do 
innego skazanego materiału (Match Audio…).
Ostatnia grupa poleceń służy do kontroli prędkości 
wyświetlanego / odtwarzanego materiału. Przyśpie-
szania, zwalniania itd.

5.3 PRACA PARAMETRYCZNA
Na prawo od okna wideo znajduje się panel pozwalający (zazwyczaj) parametrycznie kontrolować więk-
szość wprowadzanych w projekcie zmian (Video Inspector). Składa się on z szeregu grup zadaniowych, 
kontrolujących efekty wizualne i dźwiękowe, cechy geometryczne i barwne (w tym tryb mieszania i transpa-
rentność) kompozycji… w miarę stosowania poleceń, nakładania filtrów - lista obsługiwanych parametrów 
się powiększa. Znaczna część z nich może być zmienna w czasie, dla tego też na prawo od nich pojawiają 
się narzędzia kontroli 
klatek kluczowych. Dane 
można wprowadzać 
zazwyczaj na kilka 
sposobów. “Analogowo, 
przemieszczając suwaki, 
obracając pokrętła lub 
wpisując dane nume-
ryczne. W tym celu 
wystarczy kliknąć liczbę 
mającą ulec zmianie. 
W ten sposób wchodzi 
się w edycję danych 
cyfrowych, które wprowa-
dzamy z klawiatury.

5.4 PRZEJŚCIA I EFEKTY
W prawej dolnej części 
ekranu roboczego Final 
Cut Pro (w domyślnej 
konfiguracji) można 
wywołać okna efektów, 
będących zazwyczaj 
filtrami korekcyjnymi lub 
efektowymi do obrazu 
lub dźwięku oraz zestaw przejść służących do łączenia ujęć w sposób bardziej złożony, niż poprzez proste 
cięcie i działających głównie w sferze wizualnej.

5.4.1 PRZEJŚCIA
Najlepszą metodą stosowania przejść jest posiada-
nie w Timeline dwóch klipów wizualnych (lub 
audiowizualnych) leżących na tej samej wysokości 
(a najlepiej na tym samym Storyline). Oba winny 
mieć zapas czasu na swoich stykających się 
końcach (jeśli nie mają można je zrolować narzę-
dziem Trim). Następnie należy wybrać potrzebny 
wzór przejścia z palety Transition i przeciągnąć 
i upuścić go w miejsce styku obu klipów. Pojawi się 
tam panel z ikonką “przewróconej klepsydry” 

i zaczepami regulacyjnymi u obu górnych 
narożników. Przeciągając za zaczepy 
można regulować dokładne ułożenie 
czasowe,  Zaś chwytając za krawędzie 
czas trwania. Oczywiście jednocześnie 
z umieszczeniem przejścia na osi czasu 
w prawym górnym narożniku ekranu mamy 
dostęp do paramertycznych kontrolerów 
cech przejścia. Często dodatkowo na 
ekranie wideo pojawiają się uchwyty 
pozwalające na manualną korektę w/w 
cech.

5.4.2 EFEKTY WIZUALNE  
Stosowanie efektów jest jeszcze prostsze. 
Wybrany efekt wystarczy przeciągnąć 
z palety i upuścić na klip wideo lub audio 
(na Timleline). Istotna jest w tym wypadku 
kolejność nakładania efektów. W każdej 
chwili można ją zmienić przeciągając je 
w oknie z danymi paramertycznymi lub chwilowo wyłączyć odznaczając kratkę przy nazwie. W celu usunię-
cia wybranego efektu – należy zaznaczyć go w tym samym oknie i nacisnąć na klawiaturze klawisz Back-
space lub Delete.

5.6 EFEKTY DŹWIĘKOWE
W lewej górnej części okna roboczego programu 
Final Cut Pro znajduje się zestaw trzech ikon 
przełączających nas pomiędzy biblioteką zaimpor-
towanych plików i utworzonych projektów (lewa), 
gotowymi zestawami obrazów i dźwięków (środko-
wa) oraz generatorami typografii i gotowych 
do użycia teł (niczym w studiu fotograficznym), 
tekstur, kształtów itp. W bibliotece dźwiękowej 
mamy do dyspozycji utwory znajdujące się 
w bibliotece iTunes aktualnie aktywnego użytkowni-
ka oraz preinstalowane z FCPX efekty dźwiękowe. 
Po wyborze tej zakładki pojawia się po prawej 
stronie lista zdarzeń dźwiękowych, ponad nią 
zaprezentowany jest wykres waveformu aktualnie 
wybranego dźwięku, a jeszcze wyżej po prawej lista 
tematyczna tych efektów. W celu wykorzystania 
potrzebnego nam dźwięku, należy jego nazwę 
z listy, przeciągnąć na Timeline. Tam materiały 
te prezentowane są w postaci pasków o morskim 
odcieniu. Zazwyczaj podpięte poniżej Storyline.

5.7 TYTUŁÓWKA
Ostatnia ikona prowadzi do znacznego zasobu gotowych acz 
rekonfigurowalnych rozwiązań typograficznych podzielonych 
na grupy tematyczne. W wypadku naszej pracowni z dużą 
dozą ostrożnością należy podchodzić do dwóch pierwszych 
zawierających w opisach zwrot “3D”. Wymagają one stosun-
kowo nowych, mocnych komputerów.
Podczas rozmieszczania tytułówki (i innych istotnych elemen-
tów w kadrze, takich jak logotypy, infografika, twarze akto-
rów), warto pamiętać o bezpiecznych obszarach akcji 
i tytułówki. 
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Szczególnie jeżeli nasz materiał będzie emitowany dla odbiorników TV w jakości SD. Przycinają one widzia-
ny obraz. W zależności od modelu w różnym stopniu. Podobnie odbiorniki HD/UHD prezentując obraz ze 
źródła SD nie pokazują go w całości. Należy zadbać, by żaden z istotnych elementów nie był poza 
wewnętrznym polem. Jednocześnie pilnując by obraz, który komponujemy sięgał conajmniej na całe pole 
środkowe (pomiędzy marginesem, a zewnętrznym). Jeżeli masz materiał może być dystrybuowany również 
cyfrowo (np. na portalu streamingowym takim jak YouTube czy Vimeo) - należy obrazem pokryć cały 
widziany w programie FCPX kadr. W celu wyświetlenia ramek informujących o tych obszarach, w menu 
View nad oknem wideo należy wybrać polecenie Show Title/Action Safe Zones. W celu zastosowania 
wybranej tytułówki należy przeciągnąć jej miniaturkę z okna Titles na Timeline.  Jest ona wtedy reprezento-

wana fioletowym paskiem (jeszcze węższym niż materiały wizualne czy dźwiękowe). Jego parametry można 
ustalić w oknach Title Inspector i Text Inspector (znajdują się po prawej stronie u góry ekranu roboczego). 
Zaś sam tekst edytować w tym drugim.

5.8 KONTROLA PARAMETRÓW Z WYKORZYSTANIEM KRZYWYCH
Każdy z pasków reprezentujących na Timelinie materiały wizualne, adiowizualne, dźwięk czy tytułówkę 
można w każdej chwili rozwinąć do postaci łatwo 
edytowalnej technikami odręcznymi. W tym celu 
należy ów pasek kliknąć prawym klawiszem myszy 
i wybrać z menu kontekstowego polecenie Show 
Video Animation lub Show Audio Animation. Pojawia 
się wtedy przypięty do paska panel informacyjny 
z prezentacją istotnych parametrów. Dostępne są 
one w postaci paneli z checkboxem oraz (często) 
po prawej z przyciskiem rozwinięcia subpanelu 
z krzywą. Widoczne są na niej klatki kluczowe 
modelujące jej przebieg. Można przeciągać myszą 
za owe klatki (ikonki małych rombów) lub za krzywą. 
W każdej chwili można dodać klatkę (kliknięcie na 
krzywej z wciśniętym klawiszem Alt na klawiaturze) 
lub ją usunąć (zaznaczenie klatki poprzez kliknięcie, 
a następnie klawisz Backspace).
W wypadku materiałów audio zazwyczaj jest na nich 
prezentowana w sposób ciągły krzywa parametru 
wzmocnienia dźwięku (Volume) zakończona dwoma 
suwakami do wyciszenia. Wzmocnienie można 
regulować w zakresie od 0 do 150% głośności 
materiału bazowego. W trakcie regulacji wzmocnienia parametru Volume należy zwracać uwagę na barwę 
vaweformu. Jeżeli zmienia się na żółtą, zbliżamy się do strefy niebezpiecznej. Ta ostatnia jest oznaczona 
kolorem pomarańczowym. Zaleca się jej unikanie.

6. PRZYGOTOWANIE DO MASTERINGU
Ostanim etapem pracy zaliczeniowej jest wykonanie masteringu płyty Video-DVD. W tym celu w programie 
Apple iMovie należy umieścić między innymi plik audiowizualny w kontenerze multimedialnym .MOV 
zawierający znaczniki rozdziałów. Przypominam, że iMovie generuje tylko płyty w jakości SD, co znaczy, że 
zarówno materiał SD jak i HD będzie miał potem przybliżoną szczegółowość. Różnicą (może być) kadr 
ekranu (acz nie koniecznie, gdyż w/w program obsługuje też SD panoramiczne).



SKRÓCONA INSTRUKCJA DO PROGRAMU FINAL CUT PRO X - Jakub Balicki - IIS - PŁ - 2017 strona 10

6.1 DODANIE ZNACZNIKÓW ROZDZIAŁÓW
W celu dodania znacznika rozdziału należy mając widoczny w Timeline projekt (a nie klip złożony) ustawić 
głowić nad pożądanym momentem w czasie, a następnie wybrać polecenie Mark -> Markers -> Add 
Marker and Modify (skrót Alt + M). Można to wyko-
nać w miejscu gdzie istnieje dowolny materiał lub 
“niezagospodarowany” Storyline. Nie da się tego 
wykonać nad pustą przestrzenią (np. w celu wyko-
nania rozdziałów przed przygotowaniem zawartości 
filmu). Po wybraniu w/w polecenia pojawi się okno 
posiadające trzy zakładki tryby pracy oznaczone 
ikonkami na jego górze. Ikony oznaczają (od lewej): 
znacznik czasowy, adnotację, znacznik rozdziałowy. 
Należy wybrać ten ostatni i ewentualnie wpisać 
nazwę rozdziału. Polecam jednak nie korzystać 
z polskich znaków diakrytycznych, lub uzupełnić 
je (lub wpisać całe nazwy) dopiero podczas pracy 
w iMovie. Operację zakańcza się klikając w klawisz 
Done (prawa dolna część okna). Domyślnie znacznik rozdziału “przykleja” się do najwyższego elementu 
w danym miejscu w czasie na Timeline, chyba, że uprzednio zaznaczony został któryś konkretny. Jest to 
istotne. Gdyż repozycjonując elementy z “doklejonymi” znacznikami rozdziałów – repozycjonuje się równeż 
rozdziały.

6.2 ZAZNACZENIE ZAKRESU CZASOWEGO
W trakcie montażu filmu normalnym jest, że nie zawsze ma być on wyeksportowany od samego początku. 
Podobnie nie zawsze ostatni materiał audio czy wideo na linii czau ma określać jego zakończenie. W tym 

celu należy ustawić znacznik czasu na Timeline w odpowiednich pozycjach i skorzystać z poleceń z menu 
Mark takich jak Set Range Start do wskazania początku eksportowanego filmu czy Set Range End do 
wskazania jego zakończenia. Czas najlepiej wskazywać nad obszarami Storyline. Inaczej może zaistnieć 
konieczność dodatkowej jego regulacji (uchwyty po bokach żółtego obramowania).

6.3 EKSPORT FILMU
Utworzenie finalnego materiału w kontenerze .MOV wymaga rozwinięcia zakładki eksportu (Share) poprzez 
kliknięcie na skrajną ikonę w prawym górnym narożniku obszaru roboczego. Wybranie polecenia opcji 
Master File (default)… umożliwia wyeksportowanie wysokiej jakości filmu (można wyeksportować również 
materiał w idealnej jakości – pozbawionej kompresji czy wzbogaconej o kanał przezroczystości) zawierają-
cego znaczniki rozdziałów. Istotna jest przede wszystkim zakładka Settings. Znajdują się w niej (od góry) 
możliwość wyboru docelowej zawartości kontenera multimedialnego (Format). Przy wybranej Video and 
Audio otrzymujemy materiał audiowizualny (możliwe jest też publikowanie tylko jednej składowej, publiko-
wanie bezpośrednio na urządzenie, czy pod kątem emisji). Wybór typu i jakości kodowania obrazu (Video 
codec). Jako najlepsze można wskazać np: Apple ProRes 4444 XQ (ze względu na jakość koloru i przeno-
szenie kanału Alpha), Uncompressed 10-bit 422 (duża głębia bitowa kanałów, brak artefaktów kompresji, 
olbrzymie pliki). W wypadku sprzętu o mniejszej efektywności (jak stanowiska w laboratorium) zalecanym 
jest Apple ProRes 422 LT. Najwygodniejszy format (pod względem kompromisu jakości i rozmiaru) zaś 
generuje obecnie kodek H.264. Poniżej są informacje o rozdzielczości, przestrzeni kolorów, formacie 
ścieżki audio oraz bardzo istotna (pod kątem poprawnej realizacji zadania zaliczeniowego) opcja: Include 
chapter markers. Zaznaczenie przy niej checkboxsu powoduje zawarcie w materiale znaczników rozdziało-
wych czytelnych dla iDVD.
W prawym dolnym rogu okna znajduje się też ikona monitora (najechanie na nią kursorem powoduje 

wyświetlenie listy kompa-
tybilności generowanego 
pliku), oraz jasnoszary 
prostokąt z liczbą 
i dopiskiem “MB (GB, TB) 
est.” informujący o 
przewidzianym rozmiarze 
pliku, który przy tych 
nastawach eksportu się 
wygeneruje. Przed 
kliknięciem w klawisz 
Next… (otwierający okno 
dialogowe do zapisu 
pliku) warto jeszcze 
przejechać kursorem 
poziomo po ikonie 
podglądu materiału 
wyjściowego (lewa strona 
okna Master File). 
Umożliwia ono uprosz-
czone przejrzenie eksportowanego filmu.
Warto pamiętać, że eksport materiału finalnego będzie zapewne trwał dłużej niż jego czas emisyjny. 
Czasami znacznie dłużej – szczególnie w wypadku pracy na licznych warstwach obrazu i ścieżkach audio, 
intensywnym wykorzystaniu efektów, przejść czy tytułówki 3d.
Eksport wykonywany jest jako operacja w tle. Po jego zakończeniu program poinformuje. 

6.4 KOPIA ZAPASOWA
Podczas pracy warto zawsze posiadać kopię zapasową na bezpiecznym zewnętrznym nośniku. W celu jej 
wykonania wystarczy (jeżeli pracowaliśmy systematycznie korzystając z opcji Files: Copy to library storage 
location – patrz rozdział 2.1) wyłączyć FCPX (pole-
cenie Quit Final Cut Pro pod głównym menu progra-
mu), odnaleźć na dysku komputera plik wykorzysty-
wanej biblioteki, kliknąć go prawym klawiszem 
myszy i wybrać z menu kontekstowego polecenie: 
Compress “nazwa_biblioteki.fcpbundle”. 
Po (zapewne) dłuższej chwili czasu powstanie plik 
archiwum .ZIP, który można skopiować na 
bezpieczny nośnik. Plik ów może być podobnej 
wielkości co biblioteka. Zapakowanie do archiwum 
ma bowiem nie redukować rozmiar, a chronić 
zawartość w wypadku przechowywania go na 
innych partycjach niż HFS. Kopię bezpieczeństwa 
warto wykonywać przynajmniej pod koniec każdych zajęć, mając świadomość, że operacja ta może zająć 
dłuższą chwilę.
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6.1 DODANIE ZNACZNIKÓW ROZDZIAŁÓW
W celu dodania znacznika rozdziału należy mając widoczny w Timeline projekt (a nie klip złożony) ustawić 
głowić nad pożądanym momentem w czasie, a następnie wybrać polecenie Mark -> Markers -> Add 
Marker and Modify (skrót Alt + M). Można to wyko-
nać w miejscu gdzie istnieje dowolny materiał lub 
“niezagospodarowany” Storyline. Nie da się tego 
wykonać nad pustą przestrzenią (np. w celu wyko-
nania rozdziałów przed przygotowaniem zawartości 
filmu). Po wybraniu w/w polecenia pojawi się okno 
posiadające trzy zakładki tryby pracy oznaczone 
ikonkami na jego górze. Ikony oznaczają (od lewej): 
znacznik czasowy, adnotację, znacznik rozdziałowy. 
Należy wybrać ten ostatni i ewentualnie wpisać 
nazwę rozdziału. Polecam jednak nie korzystać 
z polskich znaków diakrytycznych, lub uzupełnić 
je (lub wpisać całe nazwy) dopiero podczas pracy 
w iMovie. Operację zakańcza się klikając w klawisz 
Done (prawa dolna część okna). Domyślnie znacznik rozdziału “przykleja” się do najwyższego elementu 
w danym miejscu w czasie na Timeline, chyba, że uprzednio zaznaczony został któryś konkretny. Jest to 
istotne. Gdyż repozycjonując elementy z “doklejonymi” znacznikami rozdziałów – repozycjonuje się równeż 
rozdziały.

6.2 ZAZNACZENIE ZAKRESU CZASOWEGO
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celu należy ustawić znacznik czasu na Timeline w odpowiednich pozycjach i skorzystać z poleceń z menu 
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konieczność dodatkowej jego regulacji (uchwyty po bokach żółtego obramowania).

6.3 EKSPORT FILMU
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codec). Jako najlepsze można wskazać np: Apple ProRes 4444 XQ (ze względu na jakość koloru i przeno-
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Next… (otwierający okno 
dialogowe do zapisu 
pliku) warto jeszcze 
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